EPASS Purchasing 2 - Ordering
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SN-15 Inventory Ordering

This report is primarily used by companies who look at sales trends so they can fulfill min/max ordering. This
report also has an option to fulfill backorder quantities and has the same capabilities as OE-04 Written Models
report.
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Report Parameters

Supplier: This option will let you select one or multiple suppliers.

Stock/Non-stock: This option will let you select Stock, Stock OR QOH > 0 OR QOO > 0 (Select all
models that are Stock, or any model (Stock/Non-stock) where QOH is greater than 0, or QOO is greater
than 0), Non-stock or All (Stock & Non-stock Models). It defaults to All.

New: This option will let you select the model level. Options are All, New, Used, Damaged, and
Accessory. It defaults to All and other options are not commonly used.

OEM: This option will let you select one or multiple OEMs (Original Equipment Manufacturer). The OEM
is used to define groups of brands. If one buyer is responsible for a handful of brands, you can create an
OEM in the OEM Table and then assign the OEM to each brand. This way one single OEM of ‘WP’ can
pull Maytag, Jenn air, and Whirlpool etc.

Brand: This option will let you select one or multiple brands.
Product: This option will let you select one or multiple products.
Invoice Type: This option will let you select one or multiple invoice types.

Job Status: This option will let you select one or multiple job statuses. Some companies will only order
product once it is in ‘Scheduled’ status. The job status allows you to define if you can select this job
status only once the minimum deposit has been reached and if the job status is dispatched.

Branch: This option will let you select one or multiple branches. Access to this is based on security.

Inventory Type: This option will let you select one or multiple inventory types. The inventory type is used
to define inventory. I.E. Appliance, Electronics, Furniture, Mattress etc. If one buyer is responsible for
electronics inventory types, then you can create inventory types in Inventory Types Table and then
assign the inventory type to each model. This way the user responsible for ordering electronics would run
for inventory type electronics and it will grab all the models that belong to that inventory type.

Location: This option will let you select one or multiple model locations. I.E. The model location
on invoice detail. This is useful if you are only ordering for specific locations or regions.
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Selecting a Location is optional, unless the Require Location to be Selected on PO Header option
is active in Purchasing Variables

(Tools > System Maintenance > Variables > Purchasing > General tab). If this option is active, a
Location must be selected from the dropdown list.

5
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e Sort By: Report can be sorted in different ways:
o Model
o Product/Model
o Brand/Model
o Supplier/Model

e Active: This option will let you select Active, Active or QOH > 0, Inactive Models or Both (Active and
Inactive Models). It defaults to Both.

e Order based on: This option will let you fulfill min/max quantity, and/or written quantity. |.E. It is a not
shipped model line on invoices or both min/max and written quantity. It defaults to last used.

o Min/Max Only: This option will only look at Min/Max quantity & not Written quantity.
o Min/Max + Written: This option will look at both Min/Max quantity and Written quantity.

o Written Only: This option will only look at Written quantity and not Min/Max quantity.
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e Sales History on: Options are finished or written. I.E. This option will let you see the sales history on the
report based on either finished/delivered sales or written sales.

e Print Description on Separate Line: If this option is checked, it will print the full model description on a
separate line.

e Exclude Not Saleable Locations: If this option is checked then it will exclude locations flagged as not
saleable in Tools > System Maintenance > Tables > Locations.

e Order from Terminal Location: If this option is checked when the purchase order is written, it will
populate the location on the model line in the purchase order from the Model Delivery location set in File
> Terminal Settings. If unchecked, it will order the product based on the location on the model line in
invoice detail. This option is commonly selected where inventory is received into multiple locations so the
ordering person’s terminal settings will be set to where the product is expected to arrive. This is also
connected to the Interstore Transfer system so EPASS can coordinate movement of product when it
arrives in a different location than it needs to be delivered from.

¢ Reduce QOH/Written if Serials Reserved: If this option is checked then it will reduce the QOH and
written quantity shown on the report if a serial number is reserved to an invoice. |.E. If QOH = 1 and
Written = 1 but the written invoice has reserved the serial number that is on hand, it will reduce the QOH
to zero because the one on hand is reserved. It will also reduce the written to zero because the one that
is written has a serial already reserved to it so we do not need to order one for that invoice.

e Show Models with Order Quantity = 0: If this option is checked then it will show models that do not
need to be ordered. It will include models where EPASS has calculated that zero need to be ordered
either based on the min/max and/or written depending upon the options chosen on the report selection.

e Print Model Note: If this box is checked then it will print the model note from Serial Inventory >
Maintenance on the report. This is particularly useful when you can import helpful information such as
long description, sales price information, future IRs etc. from the price list templates.

¢ Show Stock/Non-Stock Line: If this option is checked then it will show if the model is stock or non-stock
on the report.

e Show QOH per Location: If this option is checked then it will break out the QOH per location.

o Break QOO and QOH out by Serial Type: If this box is checked then it will print QOO and QOH by
serial type. Only select this if you use serial type to separate your builder, retail, and clearance inventory
as then it is beneficial to breakout both the QOO and the QOH by serial type.

o Exclude not released quantities from QOO: If this box is checked then it will exclude purchase orders
that are “not released” from the QOO. |.E. If you use releasing on purchase orders then you probably do
not want to include purchase orders that have not been released in your QOO since those are not
coming in yet.
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o Written Qty only up to Ending Date: If this box is checked then the written quantity on the report will
only include invoices scheduled for pickup or delivery up to the ending date. If this box is not checked,
the written quantity shown on the report will be for all product regardless of when it is being picked up or
delivered.

o Ending Date: This is the cut off for the invoice schedule date and invoice pickup date. It will show you
everything that is being delivered or picked up to this date.

o Show All Models with a Written Qty (even though QOH is sufficient): If this option is checked it will
show all the models with written quantity regardless of the QOH.

e Exclude Non Dispatched Job Status: If this option is checked then it will exclude non-dispatched job
statuses set on the invoice. I.E. Meaning Do Not Dispatch is checked in System Maintenance > Table >
Job Status Table. Most companies will want to see estimated dates on the report and then check with the
sales staff to see if the date is good or not and other companies place the responsibility on the
salesperson to update their invoices properly or else product will not be brought in.

¢ Include Invoices Already Ordered For or Serial Number Reserved: If this option is checked then it will
include invoices already ordered for or that already have a serial number reserved.

e Exclude COD Invoices not paid for: If this option is checked then it will exclude COD invoices not paid
in full. Most companies have policies that they will not order product until it is paid in full. If you wish to do
this and are going to be strict about the policy, then this option is good for you. This goes back to putting
the responsibility on the salesperson.

e Exclude Invoices Not Credit Approved: If this box is checked then it will exclude “Not Credit Approved”
invoices. See Credit Approval Process.

e« Only Show Invoices that have reached the minimum deposit: If this box is checked then it will only
show invoices that have reached the minimum deposit. |.E. If you have a minimum deposit rule in place,
which is set on each invoice type, then do you only want to see invoices that have reached that
minimum? This is similar to excluding COD invoices not paid for.
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Order

Appliance Sales & Service SN-15
Inventory Orderlng Sort By: Model Location: All Records
Order Based Omvin/Max + Written New/Used: New Brand: All Records
Supplier: All Records Stock / NonStoclall Active: Al Product:All Records
Ending Date:Jun 14, 2020 Report Date:May 15, 2020  System D: s, 2020 System Time: 12:05 pm Page: 1
- o ] Written Sales History
Model . Description Last Cost (QOH + QOO) - Written=Total  Min Max 0 50 90 120 150 180+ YTD
Equivalent
FF900056 METAL FILTER FOR VENTIL 0.00 3 0 8 -5 2 2 8 0 0 0 0 0 0
Main=2, S1F=1
Sernal # Loc Ret Invoice # Inv Date Customer # Name Branch Status Credit Hold  Deposit Del Date
Qty: 6 S00020002 4/9/2020 8585216045  DANIEL GEORGIE Default EST 0.00
Qty: 1 500020007 4/20/2020 8585551212  JOSE DIEGO Default EST 500.00
Qty: 1 500020007 4/20/2020 8585551212 JOSE DIEGO Default EST 500.00
P1IKG6S1B WHIRLPOOL PRODUCE PRE 0.00 0 0 1 -1 0 0 1 0 0 0 0 0 0
Serial # Loc Ret Invoice # Inv Date Customer # MName Branch Status Credit Hold  Deposit Del Date
Qty: 1 500020004 4/13/2020 8585551212  JOSE DIEGO Default EST 0.00  520/2020
SKT60M WHIRLPOOL UPRIGHT FRI 0.00 1 0 2 -1 0 0 2 0 0 0 0 0 0
Main=1
Serial # Loc Ret Invoice # Inv Date Customer # MName Branch Status Credit Hold  Deposit Del Date
Qty: 1 500020004 4/13/2020 8585551212  JOSE DIEGO Default EST 0.00  520/2020
YKFEDS00ESS KITCHENAID ELECTRIC RAN 0.00 0 0 1 -1 0 0 1 0 0 0 0 0 0
Serial # Loc Ret Invoice # Inv Date Customer # Name Branch Status Credit Hold  Deposit Del Date
Qty: 1 500020006 4/14/2020 8585216945  DANIEL GEORGIE Default EST 1,200.00  5/15/2020
YMEDC465HW MAYTAG ELECTRIC DRYER 492.00 1 2 5 -2 0 0 2 3 0 0 0 0 0
Main=1
YMMV1175JZ MAYTAG OVER THE RANGEM  312.00 2 3 7 0 5 5 4 3 0 0 0 0 0
Main=2
Serial # Loc Ret Invoice # Inv Date Customer # Name Branch Status Credit Hold  Deposit Del Date
Qty: 1 500020007 4/20/2020 8585551212  JOSE DIEGO Default EST 300,00 5/14/2020
Qty: 1 500020006 4/14/2020 8385216945  DANIEL GEORGIE Default EST 1.200.00  5/15/2020
Total Models Selected 6

At the top of the report, there is an Order button. Once you click on Order it will open the “Create Orders” window
(see below) where it will show each model with a written quantity.

If Include Stock Orders is checked, then it will show models that need to be ordered based on the min/max
quantity. Select the models you want to order and then click on Create PO to create the PO.
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r — —
I3 Create Orders [= = =]
@ Order | PO Mumber | RSY Exclusive | Model Code | Oty | Reference | Location Code | Invoice PO Code | Salesperson | Invoice Code | Irvnice Start D ate: | Sold To Code ‘ Sold Ta Mame | So

FF300056 5 500020002 4/3/2020 8585216345 GEORGIE G4
P1KGES1E 1 500020004 413/2020 8585551212 DIEGOD G4
YKFEDSOD. 1 500020006 414/2020 2585216545 GEORGIE B2

<

Unzelect Al ¥ Include Stock Orders Excel Create PO Cancel

Clicking on the Create PO button will generate the PO. After EPASS has created the PO, you'll notice the report
refreshes and now it displays the list of POs that were automatically created.

B3 Create Orders EI = @
E;l Order | PO Number | RS5Y Exclusive | Model Code | Gty | Reference | Location Code | Invoice PO Code | Salesperson | Invoice Code | Irvoice Start Date | Sold To Code | Sold To Name | So
O 1166 FF300056 5 500020002 4/3/2020 8585216345 GEORGIE Sh
] 1168 PIKGES1B 1 500020004 4/13/2020 8585551212 DIEGO Sh
O 1168 YKFEDSOD0... 1 500020006 4/14/2020 8585216345 GEORGIE Sh
£ >
W Include Stock Orders Eucel Canuel

b ished

Once the PO number is generated, either copy the PO# from the report and paste it into Purchasing >
Maintenance or use Purchasing > Find POs to find the PO number then either print, email or use the Purchasing

> PO Export function to send the PO to the vendor.
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5 [= = =]
Search Ophions Chick here to make this your default Search
Search Far | By |F'D i j Matching | Equal -
Search
|AND j For | By |Supplier j M atching
- Supplier 5] |PO# | Supplier | Buyer | Fieference # | Supp Inv# | PackiiSlp # |BO nv 4 |~ Stated |Ordered |DateRece| Costed | Finished | Total Ordered
#| 1168 [MISC | | [ | | | 05415720 |05/15/20 | | | | 1780.09
B3+ Review: PO # 1168 - Review Model =] = =)
Type | Rel | Item:/Maodel Eodel Description | Drdeled| .&mount| Heceivedl Sugl Status| BO Inw # | R
b ol P1KGES 1B WwHIRLFOOL PRODUCE FRESE. . 1 3.09 i 1 0 500020004
YEFEDBOOESS  KITCHEMAID ELECTRIC BAMGE . 50 (0E

< >
ftem T Model T Comment T Freight
Model  UK| [vkrEDs00ESS | |KITCHENAID ELECTRIC RANGE Received [00/00/00 | [ Minimum Order
Serial # | Location | Invoice | 0.00
QoH Qoo
S - L ! | | | Total Ordered
List Price 000  Reserved 1 1.780.03
Received
A Cost Ordered
verage Cos 2100.00 rdere: 1 ’7000
Last Cost 000 Received il Total Received
- ; 0.o0
Original Cost nog  Prev Received B [ Order Exclusive Costed
Landed Cost pop  Total Received 0 v Feleased 0.0
Standard Cost 1,771.00  Location ,—_| Serial Type ALL - Tatal Costed
Quoted Cost 1,771.00 ™ Receive toLoc BO Invoice # SO0020006 0.0 -
Record Caunt Refresh |
Discounts 000 Reference ET& Date |DD£DD£DD J
_ As of 515/2020
Urit Cost [ 000 EwtUritCost [ om Packing Slip # -
Factor 10000  EwtFactored Cost 0.00 Supplier lreice # Iﬁl
‘ustomize Home Screen

Segial | | | | | E st | | Freight Header

Exclusive Reserve and Unique Selling Price

This function allows users to reserve a specific serial number on the invoice, so that only ‘that exact serial
number’ will be shipped to the customer.

Reserve Serial and Exclusive Reserve Security Options

The multi-layered security options for the serial reserving system in EPASS allow you to create unique security
option profiles to meet the needs of your staff and business.
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Instructions for accessing the security options, as well as examples of different security option profiles are shown

here:

To Assign or Remove Reserve Security Options

1. Go to Tools > System Maintenance. On the Tables tab, select User Security, and then click Open.

2. Select a User Group from the list, and then click Security.

3. In the Keyword search box, enter RESERVE. In the list on the left, click Serial Inventory.

4. Select the security options from the list.

R&D Business Systems Ltd.
TF: 888.629.4218

sales@epass.software

5

Search far Security Options

k.ewword |reserve

[Fveaizing

[tem Irwent-:uri

Qverdes

Security Option Profiles

Allow the User to Only Reserve Stock or Non-Stock Serials marked as "Reserve Exclusive" Allow the User to
Reserve all Stock Serials Allow the User to Reserve a Stock or Non-Stock Serial, but not Exclusive Reserve
Allow the User to Reserve Stock and Non-Stock (special order) Serials Allow the User to Reserve Any Serial

Secrity Option

kodel Maintenance: Reserved

Reserve Stock Sernial [R5 Exclusive unchecked)
Reszerve Stock Sernial [R5 Excluzive checked]
Rezerve Non-Stock Senal [R5SY Excluzive unchecked)
Rezerve Non-Stock Senal [R5SY Excluzive checked]
Fiezerve Senal - Qveride Serial Type

Feszerve Senal - Overide COD Balance

Reserve Senal - Override b ax Days Out

FReserve Exclusive [any Serial]

Cancel Feserve

Cancel Excluzive Reserve

Reports: SM-41 Reserved |nventory Mot Shipped

Cancel Reserve Security Option

The Cancel Reserve security option enables a user to remove Exclusive Reserve status from any serial
number, and to remove the Reserve Exclusive when Ordering selection on an invoice model line.

https://epass.software/about/welcome-to-epass-user-conference-2025/
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63 - Invoice # 5441 - CORSIN, MIMI - Review Model o] B [
Type | Pack | tem | Loc | Description | aty| Amount| Tax 1| Tax2 | Tax 3| Staws |
Comment No This Invoice has been split, further det... 0 0.00
Model Noe  1335BKU DIEHVWASHER 1 50999 HMNe Ne Mo  Commitied
Misc No  DEL DELWERY 1 7850 Mo No Yes
Model No  JVW1880WF MICROHOOD 1.8CUFT 1100 WATTS 1 41959 MNo Yes No  Committed
1

JVWM1BE0CF MICROMOOD 30 BISQUIT

Mo  Committed

tem Model | Llabor | Msc | Comment | Waranty | Payment | Tax | Package | Signature |

Model i.IVH‘ISEﬂEF J|Hmumauu3ualsuurr Ordered | 1 ||.1 j[ 48999 [ Package Trilﬂl—{
Location | __| [Main Stock Shipped 0 Total | 48999 [ o0 SR | oo0

sku# [ Seral |Locaton | QoM 12 Std.Cost | 0.00 [Dewvery |

R | ' untm-ail“_? Avg.Cost | 31400 |2017-10-11 _|

Brand  [GENERAL ELECTRI Color | ~| @oo [_E Landed Cost 0.00 Status
Product | Reference Reserved [ Rpl Cost op |Commited
i | : Created
oz | SR - famn— [2017-10-1
Mir Wiy | 0 Months ¥ Auto Backorder [~ Reserve Exclusive when Ordering Modified
Note I =i 7 | voro0ioo
el | X0 foonoo |

“omee | Diseoust invoice Total | g
“ews | spmipe| | Meader | add | E | peee | et | AdeFromcan | T

Enabling the Reserve Exclusive when Ordering option will tell Purchasing to exclusive reserve order for this
invoice and disabling the option will tell Purchasing NOT to exclusive reserve order for the invoice. This option is
only applicable for a backorder and is not needed to reserve a serial number that is already in stock.

System Maintenance > Invoicing Variables

If you check Allow Oversell if Exclusive Reserve serials are available then you must also check Force Reserve
when Selling Obsolete/Inactive Models first for it to work.

Force Reserve when Selling Obsolete/Inactive Models can work independently.

-11 -
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I Invoicing Variables = |

f Tax T Passwords T Tilles T ‘waranty EDI ]
General |  Update |  Pinting | Posting

=
Labor
_Concel |

™ Automatic Restocking ¥ Dispatching .
¥ Accounts Receivable ™ Automatic Labor
W Auto Commit Payments I Quick Cash Sales
WV History [ Spilit Invoice - retain blank [tem linesz
™ Itemns to History ™ wamwhen Seling Non-Stock ltems/Models
™ Comments to Histomy ¥ Prevent Seling Obsolete ltems/Models
. W Automatic Back Order ltems ™ Prevent Selling Inactive ltems/Models
™ Only from Same Branch I Include N /4 as Available To Sell
| ¥ Automatic Back Order Models [T Force Reserve when Seling Obsolete / Inactive Models

[ - : B Allow Oversell if Exclusive Reserve senals are
| ¥ Retain ltem Location available
Updaste Standard/Landed Cost on Model

[T Default Item Location from Route r During Edit/Finish

v Automatic Recalculate Packages v Update Standard/Landed Cost on Copy
. v AddDetad - Defaul to In Package v Copy Documents on Copy

[ Update tem Location When R outing [T Copy Notepad

¥ Spiit Invoice Keep Mumber Series v ‘Wam'When Sold-To Customer Haz Other Open |rvoices
| ¥ Allow Past Dates On Spit [¥ Display AR Payment In Detai

[~ se Customer Payment Type for Copy & Display AR Adyustment In Detail

= Use Customer Invoice Type for Copy

Irvvioice

| W Append Service Performed Codes
[ Allow Signature line with no Signature

-12 -
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System Maintenance > Location Table
o |
Code 2

Description |STGRE

Branch |1 _| |

General Options
[~ Add Location for new tems

[~ Show OnWeb

[¥ Immediate Ship

~The following options apply when a Serial Number arrives in this
location (by Receive, Transfer, Edit Serial, etc.)

Change to [ _| | * BLAMNK = Don't change Serial Type

Serial Type
[¥ Exclude ‘Special Serial Types

[T MNen-Saleable ¥ Exclude 'Special Serial Types
(product transferred to this location will be made AVAILABLE)

[ Exclusive Reserve v Exclude "Special Serial Types
(product will be made Exclusive Reserve)

[T UN-Exclusive Reserve
(product wil be made NOT Exclusive Reserve)

[+ UM-Reserve from Invoice v Exclude "‘Special Serial Types
(product wil be unreserved from any invoice)

[ Zero Unique/Tag Price [¥ Exclude ‘Special Serial Types
(product wil be updated with 50 Unique Sell Price and Tag Price)

On a specific serial number, when arriving into the location, it will update according to the options marked on the

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

location code regardless whether reserve exclusive is checked, what serial type it is, or if it is marked as

available.

Change to Serial Type: you can select whether a serial type is updated when moved into this location.

Non-Saleable: whether serials transferred to this location will be made available.

Exclusive Reserve & UN-Exclusive Reserve: only one option can be checked per location (either the serial

arriving in this location is made Exclusive Reserve, or it is made UN-Exclusive Reserve).

UN-Reserve from Invoice: determines whether when the serial moves to this location it should be UN-reserved

from an invoice.

-13 -
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Zero Unique/Tag Price: if checked, the product will be updated with $0 Unique Sell Price and Tag Price. This
would then have it on reports as zero and trigger for someone to review the Unique Pricing for this serial.

'Special’ Serial Types: you set a serial type to be 'special' or not in Tools > System Maintenance > Tables >
Serial Types

|

Code [SCLEAR oK I
Description |[SHOWROOM CLEARANCE ol |
Inventory Division |1 [ | I

Exclusive Reserve _I I

Comment Code
[ Allow Selling Exclusive Reserve below UMRP

[v Immediate Ship
[+ Prompt for Location during Exclusive Reserve
[v Special Serial Type

PO Maintenance

When in a PO, the Order Exclusive checkbox tells the system that when the serial number is received, it will

be Exclusive Reserved for the selected invoice(s). You must select an invoice in order to be able to check Order
Exclusive.

-14 -
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&3 Order Only: PO # RA0T - Add Model =Ta
Type | BemModel Code | Description | order.. |  Amount| Received | Suggest.. | Stat.. | BOWv # | e
< >
Herm T Model ] Comment T Eraight 1,
Model < |FFEF:I}1B|_|:‘." __| |FRIGIDAIRE 30 FREESTANDING ELECTRIC RANC Recetved [ooi0or00 | [ minimum Order
Invoice | aty | Reference | Date | I 0.00
SKU [2102177 QOH [ 9 QOO[ 74 T 216 2016-01-07 Total Ordered
List Price 62320 Beserved ] 281 [ 0.00
Recerved
ed
List 2 sg1es Order | 0 o
Last Cost 605.00 Received 0 Total Received
e . | 0.00
Original Cost 000 Prev Received j o0 [ Order Exclusive Select Al I et
Landed Cost 0.00 Total Received ] 0 | 0.00

Standard Cost 54500  Location lﬁ Serial Type RETAL - Total Costed
= I 0.00
Quoted Cost £05.00 ¥ Receive to Loc BO lnvoice #
: e Refresh
Discounts 1500 Reference ETA Date Cor00n00
Unit Cost 000 ExtUntCost [ 000 PackingSip# .
Factor 10000 ExtFactoredCost[ oo  Supphervoices [ ﬁp‘?“

Sarial | i el Bala I oK I Cancel | Freight | Header |

Reserving Exclusive Serial from Model

When in the serial screen for a model, and if the serial number is NOT Exclusive Reserved, you can then choose
to regular Reserve it or Reserve Exclusive.

£ Serial £ for Model JVM1860CF, MICRO/HOOD 30 BISQUIT = |
Summary Details

Loc QOH ? Serial # Avail [Loc | Serial Type | Exclusive |Ordered for lny Unigue Pricg Tag Price |Bin | Suppl. Invoice | Received Cost IStd. Cost |Features [*

7 234ERFT RETAIL YES 0.00) 0.00 2017-10-05 0.00 0.00|

BLD 5 " |34srTGG8ES SCLEAR |YES 250.00| 499.99 2017-10-11 0.00 200.00|

s 1 T |3asTGHS RETAIL 0.00| 0.00 2017-10-05 0.00 0.00|

: ST893HIF Ne |DAM |RETAIL 0.00| 0.00 2017-10-05 0.00/ 0.0

» F RETAIL 0.00 0.00 2017-10-05 0.00 0.00

: GHNRETS 52 |RETAL 0.00) 0.00 2017-10-05 0.00 0.00|

__ |GJKMHYS6T SCLEAR  [YES 279.00) 499.99 2017-10-05 0.00 250.00

__|HIYUBTSE FLOOR YES 300.00 499.99 2017-10-05 0.00 250.00

__ |RFGTSETY SCLEAR |YES 300.00 489.95 2017-10-05 0.004 274.50

___|RTGSETHI BLDR | BLDR 0.00| 0.00 2017-10-05 0.00 0.00|

___|RTGHYE&T78U BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00|

___|RTGYHETBU) BLDR|BLDR 0.00) 0.00 2017-10-05 0.00 0.00|

___|RTYHUETS BLDR|BLDR 0.00) 0.00 2017-10-08 0.00 0.00|

__|THUJKKOSE BLDR |BLDR 0.00 0.00 2017-10-05 0.004 0.00)
4 | | »

Reserve Price N
Exclsire | Reserve it | Protection Review Add | Edit ‘ Delete Exit ‘

If the model serial # is marked Exclusive — YES, you can ONLY Reserve Exclusive from the serial screen.
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E5 : Serial # for Mode!l JVM1860CF, MICRO/HOOD 30 BISQUIT

- Summary -
Loc__|aoH
7
BLDR 5
52 1

234ERFT
345RTGESS
345TGHE
STBY3HIF
FIHFT4HF
GHNRE78
GJKMHYS67
—_|nivusrss
_|rrFaTSeTY
__|rTGS6TH
—_|rTeHYsTRU
___|RTGYHE78UJ

Det
EZ' Serial #

RTYHUETE
THUJIKOSE

Rese
Exclush

|

Avail

No

|Loc |

DAM

BLOR
BLOR
BLDR
BLDR
BLDR.

Serial Type | Exclusive | Ordered for In{ Unigue Pri
RETAIL YES 0.00
SCLEAR  |YES 250.00
RETAIL 0.00
RETAIL 0.00
RETAIL 0.00

Price

Protection

Review | Add ‘

Tag Price
0.00|
499 .99
0.00|
0.00|
0.00|
0.00|

499.99

Suppl. Invoice

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

Received

2017-10-05
2017-10-11
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05
2017-10-05

Cost

===~

Sid. Cost | Features |°

0.00
200.00
0.00
0.00
0.00
0.00

|~

You highlight the serial # you want to reserve exclusive and click on the Reserve Exclusive button. You will then
select the invoice you want to exclusive reserve the serial # for and click OK.

£5 - Reserve Serial# 234ERFT for Model JVM1860CF, MICRO,/HOOD 30 BISQUIT

E==[E=n <

Invoice Customer
O
[ s43s 5329232
[0 sa43s 5329232
[] saz= 5329232
O saa 2055452910

Name

LORNE KLASS. ..
LORNE KLASS...
LORMNE KLASS. ..
MiMI CORSINI

OK

PO

-16 -

Qty Inv. Date

1 2017-08-02
1 2017-08-02
1 2017-08-02
1 2017-08-27

Cancel |

EPASS now updates the Ordered for Invoice column with the invoice number.

Del. Date

2017-08-04
2017-08-04
2017-08-04
2017-10-10

Job 5t.

SCHED
SCHED
SCHED
SCHED
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@+ Serial # for Model JVM1860CF, MICRO/HOOD 30 BISQUIT =] & =4
Summary Details
Loc| QOH ?; Serial # Avail |Loc |SeriaIType |Exclusi\re Ordered for hvl Unique Pri) Tag Price |Bin | Suppl Invoice | Received | Cost | Std. Cost |Feah
— | —;J_ 234ERFT RETAL  |YES 2438 279.00 399.59 2017-10-05 000  240.00
T ~_|34smTGGES SCLEAR  |YES 250,00 499.99 2017-10-11 000  200.00
—_|34sTGHE RETAL 0.00 0.00 2017-10-05 0.00 0.00|
52 1 —_|s7eoanrF No |DAM |RETAL 0.00 0.00 2017-10-08 0.00 0.00
_|FanFTanF RETAL 0.00 0.00 2017-10-05 0.00 0.00|
—|cHume7e 52 |RETAL 0.00 0.00 2017-10-05 0.00 0.00|
|eaKnvss7 SCLEAR  |VES 441 279.00 499.99 2017-10-05 000  250.00
|Huvuerss FLOOR  |VES 300.00 499,99 2017-10-05 000 25000
—_|rFeTseTY SCLEAR  |YES 300.00 489.89 2017-10-05 000 27450
—_|rreserHy BLDR BLDR 0.00 0.00 2017-10-05 0.00 0.00|
—_|rTeHYeTSU BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00|
—_|rTevHeTLl BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00|
—_|rTvHusTs BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00|
| mHuJKoSs BLDR|BLDR 0.00) 0.00 2017-10-05 0.0 0.00|
ldd | 0]
Dieseive Erice Review Add | Ed | Delete ‘ Ex |
it Protection

At this point, if you go to the invoice (example #5435), it will note Reserve Exclusive on the invoice model detail
line and the serial type is RETAIL.

If you have security and want to UN-reserve it you follow the same steps except click on UN-Reserve It.
Reserve Exclusive from Invoice

When in an invoice, you can access the serial screen to Reserve Exclusive by clicking on the QOH link.
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&5 - Invoice # 5441 - CORSINI, MIMI - Review Model =RE=E

Type | Pack | tem | Loc | Description | aty] Amount| Tax1 | Tax2 | 7ax3 | Status |

Comment No This Invoice has been spiit, further det... (] 0.00

Model No 1355BKU DISHWASHER 1 50999 No Mo No Committed

Misc No DEL DELIVERY 1 7850 No No Yes

Model No JVIN1E860WF MICROHOOD 1.8CUFT 1100 WATTS 1 41999 No Yes No Committed

Model JVM1860CF MICRO/HOOD 30 BISQUIT 1 89. Committed

Model No JYM1860CF MICRO/HOOD 30 BISQUIT 1 48999 No Yes No Committed

em Model I Labor j Misc T Comment T Warranty T Payment T Tax T Package T Signature

Model  [jvmigsocF | |micrROMHOOD 30 BiISQUIT Ordered | 1 |L1 _vJ | 48sss [ Package Trip# | 1

Location | __| main Stock Shipped 0 Total [ 48999 [ o0 Seiff | 0.00
sku# [ Serial | Location | aoH s Std. Cost | 0.00 [Detvery ~|
Equiv ]— | ! Not Avail |_1 Avg. Cost I 314.00 I 2017-10-11 _E

Brand  |GENERAL ELECTRI Color l Ll Qoo 0 Landed Cost | 0.00 Status
Committed
Product ] Reference Reserved | 5 Rpl. Cost | 0.00 I
- I Created
Po¥ | Comﬂm! =l [hman | 2017-10-11
Mir Wiy 0 Months [V Auto Backorder I~ Reserve Exclusive when Ordering Modified |
Nota I 5z I ['ooro0s00 i
| v || [oor0m0 | |
Commit Disogunt - Invoice Total 0.0
i T Sel Llr_le Header | Add I Edit | Delete | Exit Add From Cart | 2.170.46 |

You then select the serial # and click on Reserve Exclusive.

& - Serial 2 for Model IVM1860CF, MICRO/HOOD 30 BISQUIT &
IS Y ~ Details
Loc| QoH E; Serial # Avail |Loc | Serial Type | Exclusive | Ordered for In{ Unique Pricl Suppl. Invoice | Received Cost [Std. Cost |Featur
7 | [ |234ERFT RETAIL YES 0.00 2017-10-05 0.00| 0.0
LD g __ |345RTGGES SCLEAR YES 250.00 2017-10-11 0.00| 200.0
T __ |345TGHe RETAIL 0.00 2017-10-05 0.00| 0.0
s2| 1 __ |57893HF No |DAM |RETAIL 0.00 2017-10-05 0.00 0.0
FJHFT4HF RETAIL 0.00 2017-10-05

0.00| D.I}E1

GHNRETS S$2 |RETAL

HIYUBTS8 FLOOR YES 300.00, 499,99 2017-10-05 0.00| 250.0

—|rroTSeTY SCLEAR  |YES 30000 489.99 2017-10-05 00of 27450
" |rvase7Hs BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00
" |raHversu BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00
|RTaYHeT8Us BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.00
" |rrvHusTs BLDR|BLDR 0.00 0.00 2017-10-05 0.00 0.0
ImHuikoss BLDR|BLDR 0.00] 0.00 2017-10-05 0.00 0.0
| 4 »|
Reserve Price y
Exclusive Protecton | | Beview Add | Eat | L=t Ext |

You will get a Select Location pop up where you select the location the serial currently is in (this is a double
check in case the serial states one location but you know it’s in another or you are just confirming the location).
Click OK.
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B3 - Select Location for Serial Type SCLEAR - Serial Code GIKMHYS67 = | @ !|ﬁ

Location ||

jm

0K

Cancel |

You then get a reminder pop up that this serial has a Unique Sell Price. Click OK. EPASS now updates the
Ordered for Invoice column with the invoice number. Click exit.

If you have security and want to UN-reserve it you follow the same steps except click on UN-Reserve t.

£3 - Serial # for Model JVM1860CF, MICRO/HOOD 30 BISQUIT o] @
Summary Details
Loc| QOH ﬁ Serial # Avail |Loc | Serial Type | Exclusive |0rdereﬂ for inv | Unique Prid Tag Price |Bn |Suggl. Invoice | Received I Cost Std. Cost |Fenh
7 234ERFT RETAIL YES 0.00 0.00i 2017-10-05 0.00| 0.00
\LDi g 345RTGGES SCLEAR YES 250.00 ABQ.BQI 2017-10-11 0.00| 200.00
= 345TGHE RETAIL 0.00/ 0.00| 2017-10-05 0.00] 0.000
s2 1 57853HIF No [DAM |RETAIL 0.00) 0.00) 2017-10-05 0.00 0.00
FJHFT4HF RETAIL 0.00 0.00] 2017-10-05 0.00| 0.000

RETAIL

0.00

2017-10-05

0.00

0.00

RFGTSETY SCLEAR YES 300.00 | 2017-10-05 0.00| 274.50
RTGSETHJ BLDR |BLDR 0.00 O.DOI 2017-10-05 0.00| 0.00
RTGHYETEU BLDR|BLDR 0.00 O.DDI 2017-10-05 0.00| 0.00
RTGYHET8UJ BLDR|BLDR 0.00 U.DOI 2017-10-05 0.00 0.00
RTYHUSTS BLDR|BLDR 0.00 O.DOI 2017-10-05 0.00 0.00
THUJIKOSE BLDR|BLDR 0.00) 0.00 2017-10-05 | 0.00| 0.00
I — i
Unreserve Price - -
it Protection Review Add | Edit ‘ Delete | Exit ‘

Unique Selling Price (USP)

Allows a unique sell price to be assigned to a serial number. When you update the Unique Sell Price field, the
serial number will also automatically by set as Reserve Exclusive and Available.
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&3 - Edit Serial # RFGT567Y for Model JVM1860CF, MICRO/HOOD 30 BISQUIT e 2 [
Serial Detail | Eca

Serial Number |RFGTSETY Available v

Run # [ Serial Type |RETAIL _ oK

Location | _| Barcode ID [

Received [ 2017-10-05 J Raw Barcode I Cancel

Actual Cost I p.0p0 Floor Plan |

Freight Amount I o.00 Floor Due I 2017-10-05 _J

Dep and Adj I 0.00 TrustDocument |

Discounts I 0.00 TrustLine # 0

Cost I 0.00 Bin Location [=|

Standard Cost ]

Unigque Sell Price — Seliing Invoice

I
|
27450  Status I
|
|

Tag Price | Ordered for Inv Reserve I
PO # [ Reserve Exclusive v
Supplier Invoice ] E’;ﬂ:ﬂt:fg:;:we | _|
Freight Invoice # | Supplier [KEY B
Features Spiff
Amount 0.00
Start | 00/00/00 I
Notes

End | 00/00/00 |

Unique Sell Price: the field will highlight red when a unique sell price is entered.
When a serial number has a unique sell price, you can only Reserve Exclusive (you cannot regular reserve it).

When you reserve exclusive a serial with a unique sell price, you will get a message to check your pricing. The
invoice detail line STD cost and Spiff $ will update according to the serial detail when exclusive reserving the
serial for that invoice.

It is common that a serial number with a unique sell price is designated a different serial type such as SCLEAR
Showroom Clearance. If so, you will also want to update the serial type on the individual serial number from
RETAIL to SCLEAR.
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Mass Unreserve Utility
There is a new Invoicing utility to mass unreserve serials from invoices. If you have multiple serial numbers that
should no longer be reserved, you can use this utility to remove the reserved status.

Set Up

Before the utility can be run, the Mass Unreserve Serials security option needs to be enabled for an appropriate
user group.

To Enable the Security Option
1. Go to Tools > System Maintenance. On the Tables tab, select User Security, and then click Open.
2. Select a User Group from the list, and then click Security.

3. In the Keyword search box, enter MASS. Select Utilities: Mass Unreserve Serials.

B Security for Usen — x

Search for Security Options

IITIEISS

|nvaicing
[tern [nventory
Serial Inventany

ok,

Cancel

[y PR ) |

4. Click OK.

Run the Mass Unreserve Utility

I\_— Only one user can run this utility at a time.

1. Go to Invoicing > Utilities > Mass Unreserve Serials. On this screen you'll narrow-down which serial
records to include in the utility by selecting specific invoice, model, and serial criteria.
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 Inventory to Unreserve From — [ Individual Models Only Q

Invoice Type MULT | |ADBACK.QT -
Job Status MULTI*  _| |[ESTIMATED.FIRM
Branch _| |ANRecords Cancel
Salesperson1 {0002 _| Hon Snow
| |Date Type [Schedule/Pick up Date -l
o Start Date hno2 |
End Date AN

Inventory Type L _| |Al Records
e Supphier |:.=.,.,u. J Lu Records
Brand —— _| |l Records
Product s _| |AlRecords
Active [Active -
- :
Being Discontinued [a ~|
[ Tocabon 0880 _] [ThomtonWarehouse |
a Serial Type [RETAIL _] RETAL
¥ Include Exclusive Reserved Serials

Select the Invoice Type and Job Status from the dropdown lists. You can select single, multiple, or all
records.

Select the Branch and Salesperson from the dropdown lists. You can select single, multiple, or all
records. Note: The Salesperson dropdown only refers to the Salesperson1 field.
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Select a Date Type from the dropdown as well as a Start Date and End Date range. The utility will only
include serial records that include the selected date type and fall within the date range.

If you want to select specific models to unreserve, select this check box.
Models to Select W Individual Models Only

Model Code

Model # |
4004
Enter the 40020

model
D number...

...and then click
Add.

You can add multiple model
numbers, and use the Remove

and Clear buttons if you need
to remove them.

Select the Inventory Type, Supplier, Brand and Product from these dropdown lists. You can select
single, multiple, or all records.

Select Active or inactive inventory, Stock items or non-stock items, and items that are Being
Discounted or not.

Select single, multiple, or all Locations from the dropdown, as well as the Serial Type. If you also want
to Include Exclusive Reserved Serials, select the checkbox.

2. Click OK. The Mass Unreserve list grid opens. The grid lists all serial records that match the criteria you
set above.
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7| Mass Unreserve Serial Numbers

Select Al

i

| Model | Serial | Serial Type | Lacation | Reserved To lnvaoice | Invoice Typel Job Status | Schedule/Pickup Datel Requested Date | Received Date | Reserved Date
a B3ECDE0SMS 123341321323 ALL FH BS00000003-LOTS ES UMNCONF...  2023-01-25 2023-01-20 2023-m-20
a BIECOAOSMS 4332332232922 ALL FH BS00000003-L0TE ES UMCONF...  2023-M-25 2023-01-20 2023-m-20
a BIBCOSOSNS 123456783 ALL FerH BSO0000003-L0T7 BS UMCONF...  2023-0-25 20221215 2023-m-20
a DUH302520C 12345673389 ALL FerH BSO0000003-L0T2 BS UMCONF...  2023-0-25 20221215 20221215
a DUH302520C 123456788 ALL Tw'H BS00000003-LOT3 BS UMCONF. 2023-01-25 2022-1215 2023-01-20
a DUH302520C 867757676767 ALL Tw'H BS00000003-LOT4 BS UMCONF. 2023-01-25 2023-01-20 2023-01-20
a HDIBO5EC 12345678309898 ALL Tw'H BS00000003-LOT2 BS UMCONF. 2023-01-25 2022-1215 20221215
a W 22K BO0EW aooo2 ALL Tw'H BS 00000007 BS UMCONF. 202310-31 2022-10-31 2022-10-31
O Wi 22K BBONANW 00003 ALL FH BS00000001 BS UNCONF... 20231031 2022-10-3 2022-10-3
O Wi 22K BBONANW 00004 ALL FH BS00000001 BS UNCONF... 20231031 2022-10-3 2022-10-3
O Wi 22K BBONLN 00005 ALL FoH ES00000001 ES UNCONF... 20231031 2022-10-3 2022-10-3
O Wi 22K BRONL 00008 ALL FH ES00000001 ES UNCONF... 20231031 2022-10-3 202210-3
O Wi 22K BRONL 00007 ALL FH ES00000001 ES UNCONF... 20231031 2022-10-3 202210-3
O Wi 22K BRONL 00003 ALL FH ES00000001 ES UNCONF... 20231031 2022-10-3 202210-3

Canicel

i

3. Select the records that you want to unreserve. If you want to unreserve all of them, click Select All.

4. Click OK.

The utility runs and unreserves the serial records that you selected.

SMIRES
SNUNRES
Model shows "unreserved"
in the PO-18 Audit Trail
report
Example

A model is unreserved on a PO transfer request.

b Llass Induchon Kange, >

36 Classic Induction Range, 5
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1~ Seach Dpbora Click here o make this youwr default Search

Soarch For | By |Modelfiem # =] Maching [Equd - S
[a8D =] Foe | By |Miodelfiem # x| Matching [Equdl bl
[iD =] For | B [odehen® =] M#heo [Eow 5]

perry | somige | Cpmoe | Owoe | g [ povew | oy > "
Model is reserved and
appears on the transfer

request

1'] blgns Unresenve Senal Mt b L= ] Iﬁ".!.ﬁ.._i
| Madel | Sensd | Sensl T Locston | Flewereed Tolmemos | Insosce T Sl Sishan [ Dste
= RETaL ESTDEL.. 20a04n0-27 JAA0

WARNING

Eﬁ AR FOU JURE Yol WS 86 unntsern all of The seincbed Seral?

_m [ w ]

Mass Unreserve utility
is run

M

~ Seanch Opbions Chick here lo make this your defsull Search
Soaich For [IRE By [Modelliem 8 =] Moching [Eque -]
[amD =] Fee [ By |Miodelfiem # =] Maichrg [Eou -
[amp -] Fee | By [Modeltem # | Matchmg [Eou -
* Modellbemn | Serialsl [ow [Fom JTo [ DotcRegued | bvoice [Stohes | Cocted By [ Botch Humber |

Model is deleted from
the transfer request
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Type | Pack | Item [ Loe [ Deseiption [ ay]  Awoura] Taxd | Tax2 | Tae3| Stauz |
This Irveoece has been splt huathes dela 1]

M ol 3h siat Ir 1
e Open ard Inspect Product Befoe Dele. 1 Commithed
Comimert Pleape open and nspect o ary dama. . o
Misc Ho ey Charae bo Verdor on Redebrey 1 Ho Ma Mo
Paprnent FT [1] Commathed

Ben | Model | Lsbor | Muc | Commert | wanenty | Pament |  Tax | Packege | Signatwe |
Modd (D ] d [ 1 [ = I Package  Trpf[1
[FE |  Modelis no longer R m— Tota [ set [ am
sk [ reserved on the o

: invoice g Debveg ' T
ot I— u— P
Brad  [Fishes & Paykel | 2
Product [induction Rangs  Color T o] e IE“"“"
MWy [T 24 Feshres T Iwento Type [AFRE Cicied
PO# [ Reeence [T [ auoBackande |
Bonch [Dafad | Commision | =] I Reserve Exchusive I
Hote

| r M [oovonoo |

~ Notes -

@ SystemNotes | ¥ SokdToTets [~ BEToTemts Since: [5718/2020 ] | oK.

1RS021 106:27.35 Juser JTO Reserved Modet SN >Egag
JVZRENZY_(DG:27.17 |Fieid Changed - Fiekd from [CONCEALED] to 1), FY
172772021 [11:22:53 |Wating on ETA for purchasing
102172020 | 1003815 |

1072072020 | 10:35:58 | - Note is auto-

generated for the
unreserved model.

SNEENS = T S0 Llasse Induchon Kange, > I I

SNUNRES e — 36 Classic Induction Range,5 B

Model shows "unreserved"

in the PO-18 Audit Trail
report
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Auto Reserve
Overview

The purpose of the Auto Reserve utility is to allocate serials on hand and reserve models to open purchase
orders. Before running the OE-04 Written Models and SN-15 Ordering reports, it is important to first reserve what
is currently in inventory and allocate models to on order POs.

This guide is intended to help you understand how the utility selects serials to reserve based on selected options
and parameters.

Security Options
There are two security options associated with the Auto Reserve Utility.
o Utilities: Auto Reserve Serial Numbers gives the user access to the Auto Reserve utility.

e Auto Reserve Serial - Override COD Balance gives the user the option to include invoices with a COD
balance when the utility is run.

To Enable the Security Options
1. Go to Tools > System Maintenance.

2. On the Tables tab, click User Security, and then click Open.

B3 Options — >
Tables T Wariablez
S alesperson ~
Serial Type

Service Account

Service Performed

Ship Yia

Transfer Status

Trip Charge

et Of Measure

|lzer Security

Wharranty Type

YWeh Tags

YWireless Terminal A

3. Select a User or Group from the list, and then click Security.
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5

Search Optiong

Search Far | By [ID ﬂ Matching |Anmakere | Type |E':'th ﬂ Search
Security Option === | |All Records Shaw |,-“.s.|| ﬂ
| M ame Tupe Group Obzolete ﬂ
__|ADMIN Adrministrator Group Mo
Ak Anwen Kavousi Idzer SvalM Mo —
AR Acoounts Payable Group Mo
___|AR Accounts Feceivable Group Mo
ASH Agziztant Store Manager Group Mo

L} C Chiris
AR CAPI AP Uzer Yz
___|CHRIS Chiriz Stark, Idger SM Mo
[ | CLAR, Clara Choo Idzer SALES Mo
FIMAR Finananre and Arconnbinn [3rann M ﬂ
Add Edit Delete E xit

Frint | ﬁecurityJ\J Beview
b

4. In the Keyword field, enter auto reserve.

5. Under Invoicing, enable Utilities: Auto Reserve Serial Numbers. This allows the user to access the utility
from the Invoicing menu.

B

Search for Security Options

K.epword |auto reserve

Inwicing
Senal lnventory

Security Option
[tilities: Auta Reserve Senal Mumbers

N

6. Under Serial Inventory, enable Auto Reserve Serial - Override COD Balance. This give the user the
option to include invoices with a COD balance when running the utility.
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B Security fo

Search for Security Options

Fewvord |auto reserve

Irvaicin Security Option
Auto Reserve Senal - Overide COD Balance

7. Click OK to close the Security Options window.
Starting the Auto Reserve Utility

e Go to Invoicing > Utilities, and then click Auto Reserve Serial Numbers.
How does the utility know which invoice model to select?

The utility selects models based on the selection in the Invoice Model Selection dropdown.

Invoices to Select [ Individual Invoices Only

Invoice Model Selection Only check models NOT linkedto aPD v |
Unly check models NOT linked to a PO

For Branch Only check models that ARE linked to a PO
. Check all models (linked to a PO or not)
Irwoice Tune Iewwws T TAN Dammrdn

There are 3 options to choose from:
e Only check models NOT linked to a PO
e Only check models that ARE linked to a PO
e Check all models (linked to a PO or not)
Selection Criteria
The following criteria must be met in order for the invoices to be selected by the utility:
¢ Invoice Status is Open or Committed.
e Invoice is not an Estimate.

¢ Models have not been reserved.
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o Models are not exclusive reserve.

¢ The quantity on the models is greater than 0.
e Models have not been fully shipped.
¢ Invoice Type allows reserving.

e The current date, less the Schedule or Pickup Date, meets the limit on reserving serials in advance for
the Invoice Type. For example, if the Schedule or Pickup Date = Mar 31/22 and the current date is Mar
18/22 then the difference is 13 days. The 13 days is compared to the max number of days to reserve on
the Invoice Type.

o If Payment Type is COD, then the invoice must not have an outstanding balance.
info

COD invoices with balances can be included by selecting the Include Invoices with COD Balance checkbox.

Invoices to Select [ Individual lnvoices Only

Invoice Model Selection [ ply check models NOT linkedto aPD |

Far Branch _ | |alRecords
Invaice Type _ | |l Records
Job Statug s | 4] Records
[ Exclude Mon Dizpatch Job Status
Route _ | |l Records
Date Type | Schedule/Pick up Date |

Start Date B/942025
End Date G/9/2025

Process Orders by: |DE|iVE[_'.-'.-"F'iI3kL,I|:I Date ﬂ
s | &l Reconds

* |t iz the location an lnvoice Model Line

Location Delivering Fram:

Iv include [rvoice with COD B alance

L

When you run the utility with this setting checked, EPASS will prompt you for confirmation.
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l i Include Invoices with COD Balance?

Yes | Mo |

If the checkbox is unavailable, then you don't have the necessary security. See Security Options earlier in this
guide for more information.

o If Payment Type is COD, check that Customer Credit Hold is not selected. (Open the Bill To Customer's
record and then go to the Credit tab.)

- Edit Customer 232595 Nelson e B2 [[EEs]
Pricing Credit T b ailing List T Web T Documents T E=IMatepad

Balance | -22,939.51 oK.
YT Purchase | £.552.89
Last r'ear Purchaze | 0.00 Ltz
Histary
[ Finance Company
[ Allow Charge
¥ CreditHald | 1§ Credit Hold Days Credi

[ Force Credit Approval Motepad
[~ 30 Day Account

Parameters
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| Invoice Auto Reserve Serial Numbers

WARNING !!!

Thiz procedure will allocate senal numbers on hand to invoices
gaoing out z00n.

—Invoices to Sefect——— 1 Individual Invaices Only
These filters are

from the invoice
header. The Start

Iwoice Model Selection | 0y check models NOT linked to a PO v |

and End Dates ' For Branch | — | |AlRecords
must be future Invoice Type |* J |AII Records
dated. N
\‘ Job Status IxxxxxxxxmxxxxJ I',.;.,_" Records
[T Exclude Non Dizpatch Job Status
Route R _| |ANRecords
Date Type IScheduIer’F‘ick up Date ;I
Start D abe IW
This filter looks at End Date [g2erz0zz |
the invoice model. Process Orders by: IDeIivery."F'ickup Drate LI
P Location Delivering From: * |==m====< _| |A|| Fecords

* It iz the location on Invoice Model Line

How does the utility know which open purchase orders to select and which serial numbers to reserve?

oK
Only Process Inventory On Hand |
Orly Proces: Cancel
Only Process Open Purchase Orders

Inve Elg&egg both Inventory and Purchase Orders

Supplier sceeeemee | |A) Records
There are 3 options to choose from:

e Only Process Inventory on Hand

e Only Process Open Purchase Orders

e Process both Inventory and Open Purchase Orders

Only Process Inventory on Hand

When this option is selected, the following rules apply:
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e The serial is available

e The serial is not linked to an invoice

IEInI_I,I Process |nventorny On Hand ﬂ
[+ Show Exception Beport

Inventory to Reserve From

Supplier R | |ANRecaords
S erial Type e [ Y oy
Brand i | |&ll Records
Inventary Type [ _ | |alRecords
b adel | [l Records
Stock, |B|:|th ﬂ

W

Location Pulling From in Order:

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

oK,

Cancel

CECERRZ ~

<
<4

Only Process Open Purchase Orders

When this option is selected, the following rules apply:

e The PO is not linked to an invoice.
e The PO is not an exclusive order.

e The PO is released.

e The PO allows backorder invoices to be linked.

¢ The ETA Date must be less than Invoice Schedule / Pickup Date.
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Ok

Orly Process Dpen Purchase Orders

[w Show Exception Repart Cancel

PO's to Reserve From

Supplier | |&NRecaords
Serial Type s | [l Becords
Brand i | Al Records
Irveentory Type s _| |ARecords
b adel s | 4] Records
Stock |E-:uth j

[ Conzider Locations when processing Purchase Orders
Location Pulling From in Order:

CHECESRE ~

< |
€4

Process Both Inventory and Purchase Orders

When this option is selected, the following rules apply.
1. The utility will first check inventory on hand:
o The serial is available.
o The serial is not linked to an invoice.
2. Then it will check the open purchase orders:
o The PO is not linked to an invoice.
o The PO is not an exclusive order.

o The PO is released.
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o The PO allows backorder invoices to be linked.

o The ETA Date must be less than Invoice Schedule/Pickup Date.

¥ Show Exception Beport

= Inventory and PQO's to Reserve From

oK

Cancel

Supplier

R _I I.-'l‘-.ll Records

|
Serial T_'r'l:'e Ixxxxxxxxxxxxxxxxxxx:_l I'é"” Fecards
|

Brand _| I.-“-‘-.IIFiecnn:IS
Inventary Type |=<=<=<>=x _| I,-'l'-,ll Records
Madel Ixxxxxxxxxxxxxxxxxxx:_l I'{-,'” Fecords

Stack, IBDth ;I

[T Congider Locations when processing Purchase Orders

Location Pulling From in Order:

= =

E

< |
L4 I

OOoOoOOoOoooon
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Changing Multiple POs

If you need to make changes to a large number of Purchase Orders at once, for example, to change prices due
to an increase, you can use the Mass PO Export and Mass PO Import utilities.

PO data is exported to an Excel sheet with the Mass PO Export utility. You can then edit the data in Excel and
import it back into EPASS with the Mass PO Import utility. Use these utilities together to cancel model or item
lines on a PO by “zeroing” the quantity ordered.

PO Fields That You Can Change
o ETA Date
o Reference
e Quoted Cost
e Quantity Ordered
e Location
e Released (Y/N) — Model POs only
e Receive Location — Model POs only
e Serial Type — Model POs only
e Req Delivery Date — Model POs only
Before Starting
Enable Security Options

The EPASS user must have the Utilities: Mass PO Import and Utilities: Mass PO Export security options active to
use the utilities.

To Enable the Security Options:
1. Go to Tools > System Maintenance.
2. In the Tables tab, locate User Security, and then double-click it.
3. Select a User Group from the list, and then click Security.

4. In the Keyword search box, enter MASS PO. Select Utilities: Mass PO Import and Mass PO Export.
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Search for Secunty Options

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

Keyword [MASS PO

Secunty Option

[+] Utilities: Mass PO Import
Utilities: Mass PO E xport

5. Click OK.

Changing Multiple POs with the Import and Export Utilities

[ 1].4 |

™ senimald |

Follow this procedure to export current PO data, change it, and then import it back into EPASS.

Exporting PO Data from EPASS:

1. Go to Purchasing > Utilities > Mass PO Export.

2. Select the PO data to export by entering the Mass PO Export parameters:

"3 ] Mass PO Export o] @ ==

Export File Name  [C:\TEMP\MASS PO EXPORT.xks | oK

s B — —

upplier [oo002 ] | Cancd
&SmphTypu = _| |AlRecords

Seiial Type on RETAIL RETAIL

PO Header | I
& Date From |5n 12022 _]

To |5/672022 1

Show I R -

Drdered for Invoice Iﬁhﬂw“ j

Export Type [Madel: -

I~ Show only where not confimed
™ Suppber Invoice Fequired o be Costed
W Exchude un-eleased lines

o Export File Name: Click the Browse button (highlighted) and enter the export filename and

location.
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o Supplier/Supplier Type/Serial Type on PO Header: Expand or narrow your PO selection with
these filters. Select a single entry, multiple, or all (default).

o Date From/To: Enter the date range of PO’s you want to include in the export.

o Show: Export PO’s that are On-Order Only, Not Costed Only, or On Order & Not Costed.

o Ordered for Invoice: Export PO’s that are Ordered for an Invoice, Ordered for Stock, or All.
o Export Type: Choose to export Models or Iltems.

o Select the following options:

= Show Only Where Not Confirmed: If selected, PO’s that have not been confirmed as
received by the supplier are exported.

= Supplier Invoice Required to be Costed: If selected, the PO is exported only if the
supplier invoice is already costed.

= Exclude Un-released Lines: PO line items that have been unreleased are excluded from
the export.

3. Click OK to start the export.
Changing the PO Export Data:

Once the exporter is finished, you can edit the export file in MS Excel. You can change any data in the file
EXCEPT data in the DateStamp and LineTimeStamp columns.

caution

Altering the data in the DateStamp and LineTimeStamp columns will result in data errors when the file is
imported into EPASS.
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Do not change the
data in these two
columns!

A | B C F
L |PO Number Item Code Date Stam Line Time Stam ETA Date Refere
2_ 2022-06-16

3 2022-06-16

1_ RT17198 D78247060 2022-06-16

5

Cancelling Models or Items on a PO:

e To cancel an ordered model or item, in the QTY Ordered column, replace the amount ordered with a “0”.

| e | F | G | H | Replace the
ETA Date Reference Quoted Cost Qty Ordered Lo quantity ordered
2022-06-16 27.07 1 with "0".
2022-06-16 27.07 0
2022-06-16 60.99 2

Save any changes you make to the export file and move on to the next step: importing the data file back into
EPASS.

Importing PO Data into EPASS:

info

These instructions assume that you are importing an Excel file created by the MASS PO export utility.
1. Go to Purchasing > Utilities > Mass PO Import.

2. Do the following:
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Browse
5| Mass PO Import button
Import File Mame — |CATEMPAMASS PO EXPORT_changed.xls L, oK.
Irmport Type Miodels Line To Start Processing 2 e C |
ance
E"'fuh:nr:itl;“p':"ti”g 0 |Delete the Record j

PO # Calurnn I,.-:-.| Buartity Colurnn IH
Itern/Model # Calumn IB Location Calurnn ||
oDate Stamp Colurnn ||: . Released [v'/M] Colurnn IJ

Tirne Starnp Colurnn ID . Receive Location Calumnn IK
ETA Drate Column IE Sernial Type Colurnin ||_
Reference Colurin IF Req Ship Date Caolumn IM
Quaoted Cost Colurnn IG

* DateStamp and TimeStamp fields are not required but they are recommended becauze they uniguely identify a
gpecific Model line. [f they are not provided then the import may naot be able to update if the zame model iz on
the PO multiple times.

A Enter the file path of the export file or select it using the Browse button.

B  Import Type: Select Models or Items.

Select what happens when a model with zero quantity is imported: the record is deleted or the
quantity is set to '0.'

If you rearranged or removed columns in the export file, re-map the columns here. Otherwise,
you don’t need to edit this area.
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Enter the line number in the export file where EPASS should start processing data. If you didn't
change the export file, you can leave this at the default value of '2.'

3. Click OK to import the new PO data.

PO Split/Release

You can designate (by line or by PO) if it is released/un-released, split PO lines, release/un-release and
split at the same time, and filter or distinguish QOO and released/un-released QOO in various reports
and other forms in the system.

Released means you want the supplier to ship that portion of the order. The unreleased portion will stay
on hold until it is needed. This is used largely for builders and seasonal products so you can order
ahead but not have to use valuable warehouse space to store the products until they are needed.

Purchasing/PO Header/Supplier

There is a “Released” checkbox on the PO header, which defaults to CHECKED. If you uncheck it, then
all PO lines that you add will be considered un-released. If you edit the PO and check/un-check the box,
a message box will appear asking if you want to release/un-release all lines on the PO?

41 -

https://epass.software/about/welcome-to-epass-user-conference-2025/



EPASS

s o T W A R =&

User Conference 2025
Wednesday, October 22™ — Friday, October 24"

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

(85 Add PO Header = ==
Supplier [ ShinTo [ Documens | Notepad
POB  [aB ||  SYSTEM Buyer |Fipan S cherpenisse
Suppler | i oK
Sernal
Twe |BUILDER -
Min Oider Larcel
| 000
Total Oidered Detal
| 0.00
Tolal Costed l
| llfl# | ¥ Released ’
Supplier Note u
e ! Effecive  [po/00/00 |
00/00,00
| |_|m| Sharted OSSN T
i | T - Ordered  [30700700
¥ FRecetve to Location Fleces Iﬁ
Floor Plan | P G0
Floor Plan Days | 0 Fri I__._._.ﬂ
Cost Fachos | 1.0000
PO Detail

There is a released column in PO detail. If it is not released then it would say “NO”. There is also a split
button that opens the split/release form, but it sets focus to the currently selected PO line allowing you

to split a PO line from PO detail and release or un-release at the same time.

-42 -

https://lepass.software/about/welcome-to-epass-user-conference-2025/



EPASS

s o T W A R =&

User Conference 2025

Wednesday, October 22™ — Friday, October 24"

R&D Business Systems Ltd.
TF: 888.629.4218
sales@epass.software

B3 Order Only: PO # 1166 - Review Model =N R
Tupe | Rel | IteméModel Code | Description Ordered Amount Heceived| Sug| Status| BO Inw # | R
Maodel YMY11751Z MaYTaG OVER THE RANGE M. 1 Fzon 0 a0
Maodel YMMY11751Z MarTas OVER THE RANGE M. 1 Fzon 0 00 SVOoDs001&
Maodel Mo YMMY11781Z MayTaG OVER THE RANGE M. 1 Fzon 0 0 0 SVOODeO01&
Muodel YMMY11751Z MaYTaG OVER THE RANGE M. 2 G24.00 2 0 OR
Maodel YMEDC4ESH W MAYTAG ELECTRIC DRYER 1 492.00 1] 0 0 SYOO0s0018

YMEDCAEEH W MAYTAG ELECTRIC DRYER 3147600 1] [
< >
ftem T Model T Comment T Freight
Model UK | [vMEDC4gSHW | |MaYTAG ELECTRIC DRYER Received [00/00/00 | | Minimum Order
s 0 Serial # | Location | Inwoice | .00
SKU | | 4 QOO 4 | Total Ordered
List Price 74099 PReserved 3 3528.00
Received
& Cost Ordered
verage Cos 51320 rdere 3 ]7000
Lazt Cost 49200  Received il Total Received
35 g £24.00
Origitial Cost gon  Prev Received B[ Order Exclusive Select Al Costed
Landed Cost onon  Total Received 0 [ Released 0.00
Standard Cost 43200 Location el Tupe ALL = Tatal Costed
.00
[uaoted Cost 432,00 [ Receive to Loc BO Invoice
) Refresh |
Discounts 0.00  Reference ETA Date IEID.*'DD."DD J
Unit Cest 000 EsUritCost [ gog PackinaSip# [
Factor 1.0000  ExtFactored Cost 0.on Supplier Inbice # PIECSS;DPDINS
Senal | Cancel Balance Add ‘ Edit ‘ Delete ‘ E xit ‘ Split | Change ETA ‘ Freight ‘ Header |
Purchasing Maintenance
A split/release button on PO maintenance
-43 -

https://lepass.software/about/welcome-to-epass-user-conference-2025/



EPASS

o e - R&D Business Systems Ltd.
User Conference 2025 TF: 888.629.4218
Wednesday, October 22" — Friday, October 24" sales@epass.software
B3+ Purchasing EI = @
Search Ophonz Click here to make this your default Search
Search For | By |PD # ﬂ Matching  |Equal A
Search
|AND ﬂ For | By |Supplier j Matching | Equal -
- Supplier = PO # Supplier | Buyer Reference # |Supp lnw | Packing Slip# [BO Inv 3t [ * Stated | Ordered | DateRece| Coste
‘... MARCTINE # 1171 [wHIRL 0EMES20 [0BABA20 |05 B/20
REL I} 1170 ['wWHIRL 0B/12/20 |08/ 2420
_____ WHIRL i} 1169 [wHIRL 05/M8/20 |05418/20
3 1166 ['WHIRL 05/04/20 | 06/19/20 | 08/03/20
= 1160 [wHIRL 0443020 | 05401/20 | 0430420 | 04430
= 1161 [WwWHIRL 04M5/20 |04416/20 | 0415/20 | 04.1°
= 1155 [wWHIRL 04/14/20 | 04414420 | 04/20420
I} 1154 [wHIRL 04M14/20 | 04414/20 | 0416420 | 04020
] 1152 ['wHIRL 04413720 | 04413420 | 0413420 | 0420

|+

ldd |
Record Count

[ 9 Detail ‘ Add ‘ Edit ‘ Delete

Clicking the split/release button opens a new form which lists all models on the PO that have not yet
been received.

Excel ‘ Split ‘ Exit |

The columns are model #, ordered for invoice #, QOO (remaining quantity on order for the line), released,
and a split quantity.

You can type a split quantity directly in the list, and also check or uncheck released. If you type in a split
quantity, we will split them in the list so you can choose which quantity is released, and which is not.
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B3« Split/Release Model Lines

YMEDCAESH W I 0

Cancel

(=] & [
Modelit Ordered For Invoicedf |Drdered |Heleased ‘Splil Quantity oK,

Select All

Unzelect All

I

Once you have gone through the list and split or released as necessary, click OK to batch update the
entire PO. If you only changed one line, only that one line would get split/released.

There are also select all and deselect all buttons so you could easily release/un-release an entire PO.
QOO form (clicking the QOO hyperlink on a Model)

You can see if a model that is on order has been released or not in the purchase window for that model:

B3 - Purchase for Model YMEDCA65HW, MAYTAG ELECTRIC DRYER o] 2 ==
Search Options

[ Show Received ltems Supplier | &l Suppliers - Location |4l Locations - Serial Type |21 Senial Types - oK
| PO # | Location | Rel d | Supplier | Reference |Pckg Slip | Supp. Invoice | BO Invoice [*DateOrd |Ord|Rec| ET& | Asof |
1166 AL SWODDEDDT S 5/4/2020 1] 1]
» 3 0| 3 Wiew
Ihvaice
Yiew PO
Edit PO
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Freight Allocation

The purpose of freight allocation is to apply the freight costs that either come from the manufacturer with the
invoice or a third party billed separately to the overall item or serial cost. In most cases, freight allocation is
primarily used for serial inventory but it does allocate freight to items also. The extended cost of the serial
number will be reflected in the gross margin and the cost of goods sold. It is important to remember, if you use
this feature, your freight invoices must be allocated to inventory asset not freight expense since this amount will
become part of the serial cost.

Freight allocation is accessible from two locations: the purchasing menu or from PO detail.

Purchasing Menu

9 ePASS - XYZ Cornpany

File Invoicing = Purchasing  ltem Inventery  Serial Ir

E - Maintenance

Freight Allocation

@4 Find PO's
Supplier
Warranty Claims ’
(=§ Transfer Request »
Reports k
Utilities *

Launching the freight allocation screen from the purchasing menu will require the user to enter the supplier
invoice number for detail to populate.

PO Detail
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B - Receive & Cost: PO # 5285 - Review Model o B |3
Tupe | Rel | [temnt adel En:u:le| Description | Elrderedl .-’-‘-.mn:nunt| Heceived| Sug| Status| BO I # | R
bodel 201UMRP 201 UMRAF TEST 2 476.00 2 2 ORC 143963
bdodel MOB4BEDAWE  DISHWASHER.B PAD. 2 PVC RE. . 1 1.100.00 1 0 ORC
b odel FFE F 3005k 30" FREESTAMDIMNG ELECTRIC. .. 1 32727 1 0 ORC
F10203 LADYBLG 1 29.85 1 I

< >
tem T Madel T Comment T Freight
Model  UK| [R10203 | JLamvEUG Received |11,/7/2019 | | Minimum Drdes
QoM 00 Serial # | Location | Inwoice | 0.00
SKU QoH [ 2 QOO 1 ‘B43r5d [MAIN 653298774 | Tatal Ordered
List Price 300 Reserved 1 133312
Received
Ayerage Cost 299z  Ordered 1 193312
Last Cost 2985 FReceived 1 Total Received
. . 1.933.12
Original Cost oo Prev Received 0 I Order Exclusive Costed
Landed Cost gon Total Received 1 ¥ Releazed 193312
Standard Cost 000 Lacation l—_l Serial Type ALL - Tatal Costed
1.933.12
Luoted Cozt 2965 [ ReceivetoLoc BO Irvoice #
Refresh |
Discounts 000  Reference ETA Date 11419/2019
. &z of 114742013 | J
Urit Cost 2985 Exwt Unit Cost 25,05 PackingSlpt [
Factor 1.0000  ExtFactored Cost Y Supplier Invoice # [g53238778 P'ECEE? ;’ g’ﬂ"“s
Serial | Cancel Balance | Add | Edit | Delete | E it | | Change ETA | Freight Header |

Launching the freight allocation screen from PO detail (with a supplier invoice already applied) will auto populate
some detail into the freight allocation screen.

Freight Allocation Screen
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B3+ Freight Allocation

Supplier [=essss | LAl Records
1 Supplier Invoice Mumber |853298??4 Lipdlate Inventary
Add E53298774
Remaove
Clear Lancel
2 Freight [nvoice Number: |853298??4
3 Freight Amount: | R00.00
4 |+ Update Seria Standard Cost: Serial Cost + 000 | = 5 ©
; = \ /
PO# | Supplier Model/ltem | Serial/Quantity | Cost | 0Old Freight | Mew Freight Total Cost | 0ld Standard Cost | Mew Standard Cost
h285 0-# 201UMRP  0O002 258.00 0.00 Bh.38 303.38 253.00 258.00
5285 0-# 201UMRF - 00009 258.00 0.0a £5.38 30238 258.00 258.00
5285 0-# MDBARS... 987412346 1100.00 0.0a 27875 137875 1100.00 1100.00
RZ285 0-# FFEF300... E83431 32727 0.00 8293 410.20 32727 32727
5285 0-# F10203 843151 29.85 0.00 7.5E awH n.oa n.oo
Total Cost: 2433.12
1. The supplier invoice number will be pre-filled when launched from PO detail. You can add additional
supplier invoice numbers in case one freight bill covers multiple invoices from the vendor.
2. The freight invoice number is mandatory. Use the supplier invoice number when the freight is included in
the invoice with the product.
3. Total freight amount.
4. & 5. You can have EPASS recalculate the standard cost on each serial number to be the new cost once
freight has been applied plus a flat dollar amount or percentage.
5. The columns that are important to focus on are as follows:

o Cost: The original cost of the serial number

o Old Freight: The previous amount of freight. If you have two freight invoices, you must make the
freight amount the total of all freight invoices and make the freight invoice number a combination
of both freight invoice numbers. I.E. 1234/abcd

o New Freight: The revised freight amount
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o Total Cost: The extension of cost plus new freight

o Old Standard Cost/New Standard Cost: Only relevant if using #4; the amount will calculate
automatically

How freight is allocated

Freight is evenly divided amongst all the pieces based on their value. |.E. A $100.00 product will get half the
freight as a $200.00 product.

EPASS takes the ratio of (Individual Product Cost/The total value of all products) multiplied by Freight Amount.

Once the freight allocation screen has been filled in, click the Update Inventory button to apply the freight to the
cost of the models and items. Once you see ‘done’ on the bottom, you can close out of the screen.

B3 + Freight Allocation @

Supplier [ _ | |anRecords
Supplier Invoice Number |35251 4

Add 362514
_Pemove |

Remove

C |
Clear S

Freight [reecice Mumber: |F35251 4

Freight Amaunt: | 70.00

[~ Update Seria Standard Cost: Serial Cost + 000 g =

POH | Supplier t odel/tem | Senal/Quantity | Ciost | OId Freight | MHew Freight Total Cost | Old Standard Cost | Mew Standard Cost
212 AP AZTEE4001 1 10.00 455 0.oo 1455 0.0o0 n.oo
212 AP GEN w.. 1 15.00 682 0.oo .82 0.0o n.on
2215 A4P 341241 1 B.00 273 0.oo 873 0.0o0 0.oo
215 AAP 4003003... 1 F2.00 3272 0.oo 104.72 0.0o0 0.oo
2215 AP 300104 2 5.00 228 0.oo 7.28 0.0o n.on
215 AAP hoo2024 2 21.00 956 0.oo 3056 0.0o0 0.ao
2215 AAP G0019-7 1 25.00 11.36 0.oo 3636 0.0o0 0.oo

Total Cost:  224.02

Drarel

If applying freight to an invoice that has already had freight applied, EPASS will give you a warning message to
confirm if you want to continue.
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Some of the Serial Mumbers/Item already have freight applied. That amount will
be replaced by the new Freight amount.

Do you want to Continue?

Yes Mo

Freight allocation vs the Freight tab in PO detail

Please be aware that the freight tab in the PO detail and the freight allocation feature are not connected at all.
The purpose of the freight tab is to be able to enter the expected freight amount, the amount entered here will
add to the total value of the PO but does not tie into freight allocation.

B3 Order Only: PO # 2255 - Edit Freight o B |
Type | Rel | ItemdModel Code | Description | Drderedl Armount Hecei\fedl Sugl Status| BO Inw # | R
[tem 3018373 JUST-A-BIN 1 0 5530
[tem 3124 DRYER BELT DRUM DR.[2] 2 1]

[tem 4001 TEST PART 0
[tem 300105 CATCHLEWER SEAL 0
Freight THIS IS THE FREIGHT ESTIMA... ]
< >
tem T Model T Comment T Freight ]
Minirnurn Order
500.00
Arnaurit 0.0 Total Ordered
25.00
GL Account | J | Fleceived
Reference #  [QUOTED 0.00
Taotal Received
Note THIS |5 THE FREIGHT ESTIMATE, IT ADDS TO THE TOTAL OF THE PO ’7000
BUT IS OMLY INFOMATIOMAL .
Costed
0.00
Tatal Costed
0.00
Refresh
Pieces / Points
ok, | Cancel Freight | Header |
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Allocating Freight Inventory Asset

If using the freight allocation feature, accounts payable needs to be aware as the invoices need to be applied as
an inventory asset.

B3 - Edit AP Transaction for Supplier AAP, Invoice F362514 =0 =R ==
Invoice T Adjustment T Quick Pay T Check
Supplier |.f-‘-.f-‘-.F' J |.-i'-.LITIIIh-1.f-‘-.TIE APPLIAMCE PARTS IMLC.
Arnoit @l | Discount &/F Contral
Irvoice # [F362514 Arnournt 0.00 1300 _
Irvoice O Dat 121342019 L Hold
frvoice Late |1 2/3/2013 J = [ DoMot Post
DueDate  [1/2/2020 L _
Mate PO 2212 FREIGHT To Be Distributed
| 0.00
Distribution
GIL Account Description Armount
p |1300 INWVENTORY 70.00
*
k. LCancel
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